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Section 1. General Overview 

1.1. Introduction 
Welcome to the STAAD/Pro Reinforced Concrete Designer (RC Designer).  This is part 
of the STAAD/Pro Design Studio.  For information on other components of the 
STAAD/Pro Design Studio, refer to separate documentation. 

 

The STAAD/Pro Reinforced Concrete Designer (RC Designer) is a post processor that 
works from the STAAD/Pro analysis results.  The data is passed into RC Designer 
includes the geometry, section and material properties, loads and combination 
information and analysis results. 

This manual is divided into three sections that will help you find the answers you are 
looking for. 

 

Section 2 

 
How to use RC 

Designer 

  

Section 3 

 
Engineering 
Information 

 

Section 4 

 
Reference 
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Section 2. How to use RC Designer  

2.1. Page Control Layout 
As with STAAD/Pro, RC Designer operates with Page Control.  Each mode has ‘Pages’ 
that set the layout of the application.  To turn the Page Control menu on / off, select 
‘Page Control from the Mode menu. 

The Page Control menu is comprised of two sets of the buttons, the top set which 
indicate the Mode and the lower set which are the Pages.  The Pages are dependent 
upon the current Mode. 

 

Modes 

 

 

 

Pages 

There are 2 stages in completing a design in RC Designer, they have been separated 
into 2 modes, similar in principle to the Modeling Mode and Post Processing Mode of 
STAAD/Pro.  These modes are:- 

1)  Design Layer 
This is used to set out the overall parameters of the design including which design 
code is to be implemented and which members are to be grouped and designed 
together.  Once a Design Group is defined and assigned a Design Brief, then the 
Design Mode can be entered. 

2)  Concrete Design 
The Design Mode is determined by the Design Code associated with the current 
Design Group.  This allows the user to perform the design and interrogate the design 
results. 

It is also possible to switch off Page Control from the Mode Menu if the additional space 
on the left side of the screen is required. 

 

2.2. Design Layer Mode 
There are four ‘Pages’ in the Design Layer.  Each page lays out the screen so that the 
user can easily step through the process of setting up and checking data.  They are 
read from the bottom left corner upwards.  The pages in the Design Layer are:- 

Job Information 
Envelopes 
Members 
Groups / Briefs 
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2.3. Job Information Page 
The Job Information Page is to allow the user to add additional information into the Job 
Information dialog box. 

When RC Designer is first opened, the Job Information dialog is populated with the Job 
Information entered in STAAD/Pro. 

 

2.4. Envelopes Page 
The Envelopes Page is to allow the user to define envelopes of basic loadcases and 
combination loadcases that have been defined in the analysis model.  Envelopes are 
required for Beam Design Briefs. 

 

Clicking on the New Env. Button prompts for an envelope name, then opens the 
envelope edit dialog. 

 

Basic loadcases and combinations included in the envelope by selecting them from the 
Load Cases list on the left and transferring them to the Envelope list on the right by 
highlighting them, by clicking on the loadase name and clicking on the > button.  To 
include them all, click on the >> button.  To remove them again, highlight it as above in 
the Envelope list and click on the < button.  To remove them all click on the << button.  
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To display all basic loadcases as well as the combinations, ensure that the Show 
Combinations Only check box is not set. 

 

2.5. Members Page 
The Members Page is to allow the user to combine together a number of individual 
beam elements and create members.  All designs are performed on these members. 

 

2.6. Groups / Briefs Page 
The Groups / Briefs Page is to allow the user to define Design Groups and setup the 
parameters in Design Briefs.  Any number of Design Groups and Design Briefs can be 
defined, however it is important to note that it is only possible to enter the Design Mode 
if the security device supports the design code associated with the Design Brief of the 
current Design Group. 

 

2.7. Design Mode 
The design mode is dependent on the Design Code associated with the current Design 
Group. 

Design Codes that are currently available include:- 

BS 8110 Beam 
BS8110 Column 
Eurocode 2 Beam 
Eurocode 2 Column 

 

To enter the Design Mode either select the option ‘Design’ from the Modes menu, or if 
Page Control is active, click on the ‘Concrete’ button from the Page Control menu on 
the left of the screen. 
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2.8. BS 8110 Beam 
With this Brief there are seven pages..  Each page lays out the screen so that the user 
can easily step through the process of setting up and checking data.  They are read 
from the bottom left corner upwards. 

Summary 
Design 
Main Layout 
Main Reinforcement 
Shear Layout 
Shear Reinforcement 
Drawing 
 

2.8.1.    BS8110 Beam Summary Page 
The Summary Page displays the summary of the design of the current Design Group. 

The page is laid out with a Structure View window on the left and a Member Summary 
Table on the right. 

 

2.8.2.    BS8110 Beam Design Page 
The Design Page is similar to the Summary Page, but on entering the page the Design 
Options dialog box is opened allowing the design to be initiated. 

 

2.8.3.    BS8110 Beam Main Layout Page 
The Main Layout Page graphically displays the main reinforcement resulting from the 
design of the current Design Group. 

The page is laid out with a Structure View window on the left and a main reinforcement 
diagram of the current member on the right.  The current member can be changed by 
selecting it from the pulldown menu on the second toolbar or by clicking on a member in 
the current Design Group on the Structure View window. 

 

2.8.4.    BS8110 Beam Main Reinforcement Page 
The Main Reinforcement Page displays the main reinforcement resulting from the 
design of the current Design Group as numerical data. 

The page is laid out with a Structure View window on the left and a main reinforcement 
table for the current member on the right.  The current member can be changed by 
selecting it from the pulldown menu on the second toolbar or by clicking on a member in 
the current Design Group on the Structure View window. 
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2.8.5.    BS8110 Beam Shear Layout Page 
The Beam Shear Layout Page displays the shear reinforcement resulting from the 
design of the current Design Group. 

The page is laid out with a Structure View window on the left and a Shear reinforcement 
diagram of the current member on the right.  The current member can be changed by 
selecting it from the pulldown menu on the second toolbar or by clicking on a member in 
the current Design Group on the Structure View window. 

 

2.8.6.    BS8110 Beam Shear Reinforcement Page 
The Beam Shear Reinforcement Page displays the shear reinforcement resulting from 
the design of the current Design Group as numerical data. 

The page is laid out with a Structure View window on the left with a Shear reinforcement 
table and a Shear Zones table on the right.  The current member can be changed by 
selecting it from the pulldown menu on the second toolbar or by clicking on a member in 
the current Design Group on the Structure View window. 

 

2.8.7.    BS8110 Beam Drawing Page 
The Drawing Page is used to generate a Multi-RC drawing file. 

The page is laid out with a Structure View on the left and a Bar Bending Schedule table 
for the current member on the right.  When entering the page an Export dialog box is 
automatically opened with the current beam information loaded. 

 

2.9. BS 8110 Beam Brief 
The BS8110 Beam Design Brief has 3 tabs for setting out the design parameters: 

 

2.9.1.    General 
Minimum covers.  Set the cover to the top, bottom and sides of the beams. 

Bond Co-efficients.  Set the values for use in calculating the anchorage lengths. 

Aggregate size.  The maximum size of aggregate. 

Concrete Grade.  Either select a standard grade from the pulldown list or enter the 
concrete cube strength into the user value. 

Envelope.  The beams will be designed to the forces from the envelope selected from 
the pulldown list.  (See section 11.6.3 for the Define Envelope command) 

Divide Beam.  Set the minimum number of segments that each member should be 
divided into for calculating the reinforcement.  
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2.9.2.    Main Reinforcement 
Top Bar Criteria.  Set the Minimum and Maximum allowable bar sizes to be used on 
the top of the beams.  The link hanger size is used for detailing where no reinforcement 
bars are required for bending, but bars are required for supporting links.  The Min gap 
defines the spacing between the top 2 layers. 

Bottom Bar Criteria.  Set the Minimum and Maximum allowable bar sizes to be used 
on the bottom of the beams.  The link hanger size is used for detailing where no 
reinforcement bars are required for bending, but bars are required for supporting links.  
The Min gap defines the spacing between the bottom 2 layers. 

Side Bar Criteria.  Set either the minimum bar size to be used or let the program 
calculate which bars can be used to achieve a 250mm c/c spacing on deep beams. 

Main Bar Type.  Either select a standard grade from the pulldown list or enter the steel 
yield strength into the user value and set the bending dimensions to be used with that 
strength. 

 

2.9.3.    Shear Reinforcement 
Design Shear For.  Select either centre line or column face.  Select Enhanced Shear 
Effects to include clause 3.4.5.8.  Select Include Axial Load Effects to include clause 
3.4.5.12 

Shear Bar Criteria.  Select the minimum bar size and number of legs to be used and 
set the minimum spacing.  Select either open or closed links to determine the link shape 
codes to be used with the schedule and link to Multi-RC. 

Shear Bar Type.  Either select a standard grade from the pulldown list or enter the 
steel yield strength into the user value and set the bending dimensions to be used with 
that strength. 

 

2.10. BS8110 Column 
With this Brief there are seven pages.  Each page lays out the screen so that the user 
can easily step through the process of setting up and checking data.  They are read 
from the bottom left corner upwards. 

Summary 
Input 
Design 
Main Layout 
Shear Layout 
Result 
Drawing 
 

2.10.1. BS8110 Column Summary Page 
The Summary Page displays the summary of the design of the current Design Group. 

The page is laid out with a Structure View window on the left and a Member Summary 
Table on the right. 
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2.10.2. BS8110 Column Input Page 
The Input Page displays the summary of the design of the current Design Group. 

The page is laid out with a Structure View window on the left and the Column Input table 
on the right.  The Input table is used to set the directions in which columns are braced. 

2.10.3. BS8110 Column Design Page 
The Design Page is similar to the Summary Page, but on entering the page the Design 
Options dialog box is opened allowing the design to be initiated. 

 

2.10.4. BS8110 Column Main Layout Page 
The Main Layout Page graphically displays the main reinforcement resulting from the 
design of the current Design Group. 

The page is laid out with a Structure View window on the left and a main reinforcement 
diagram of the current member on the right.  The current member can be changed by 
selecting it from the pulldown menu on the second toolbar or by clicking on a member in 
the current Design Group on the Structure View window. 

 

2.10.5. BS8110 Column Shear Layout Page 
The Beam Shear Layout Page displays the shear reinforcement resulting from the 
design of the current Design Group. 

The page is laid out with a Structure View window on the left and a Shear reinforcement 
diagram of the current member on the right.  The current member can be changed by 
selecting it from the pulldown menu on the second toolbar or by clicking on a member in 
the current Design Group on the Structure View window. 

 

2.10.6. BS8110 Column Result Page 
The Result Page displays the reinforcement resulting from the design of the current 
Design Group as numerical data. 

The page is laid out with a Structure View window on the left and a main reinforcement 
table for the current member on the right.  The current member can be changed by 
selecting it from the pulldown menu on the second toolbar or by clicking on a member in 
the current Design Group on the Structure View window. 

 

 

2.10.7. BS8110 Column Drawing Page 
The Drawing Page is used to generate a Multi-RC drawing file. 
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The page is laid out with a Structure View on the left and a Bar Bending Schedule table 
for the current member on the right.  When entering the page an Export dialog box is 
automatically opened with the current beam information loaded. 

 

2.11. BS8110 Column Brief 
The BS8110 Column Design Brief has 3 tabs for setting out the design parameters:- 

 

2.11.1. General 
Concrete grade, fcu, either selected as a standard grade (C30 to C50) or a user 
specified value (N/mm²). 

Aggregate size. 

Cover to shear links. 

Main steel strength, fy, either selected as type T (460 N/mm²), R (250 N/mm²) or a 
user specified value. 

If a user value is specified, the minimum bending radii and anchorage provided by a 
bend may also be specified. 

Minimum and maximum main bar sizes to be used in finding the most efficient 
arrangement. 

Link steel strength, as for main steel. 

Minimum link size. 

 

2.11.2. Column Factors 
Bracing conditions in x-x and y-y directions. 

Effective length factors in x-x and y-y directions. 

Slenderness limits. This may be set conservatively as 1, or calculated iteritavely. 

Area provided by starter bars (for checking the final percentage of steel). 

 

2.11.3. Member Combinations 
Select from the available list of combinations for those that are required for the design 
by selecting them and pressing the '>' button.  Pressing '>>' will select all the available 
combination results for design. 

 

2.12. Eurocode 2 Beam 
With this Brief there are seven pages..  Each page lays out the screen so that the user 
can easily step through the process of setting up and checking data.  They are read 
from the bottom left corner upwards. 
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Summary 
Design 
Main Layout 
Main Reinforcement 
Shear Layout 
Shear Reinforcement 
Drawing 
 

2.12.1. Eurocode 2 Beam Summary Page 
The Summary Page displays the summary of the design of the current Design Group. 

The page is laid out with a Structure View window on the left and a Member Summary 
Table on the right. 

 

2.12.2. Eurocode 2 Beam Design Page 
The Design Page is similar to the Summary Page, but on entering the page the Design 
Options dialog box is opened allowing the design to be initiated. 

 

2.12.3. Eurocode 2 Beam Main Layout Page 
The Main Layout Page graphically displays the main reinforcement resulting from the 
design of the current Design Group. 

The page is laid out with a Structure View window on the left and a main reinforcement 
diagram of the current member on the right.  The current member can be changed by 
selecting it from the pulldown menu on the second toolbar or by clicking on a member in 
the current Design Group on the Structure View window. 

 

2.12.4. Eurocode 2 Beam Main Reinforcement Page 
The Main Reinforcement Page displays the main reinforcement resulting from the 
design of the current Design Group as numerical data. 

The page is laid out with a Structure View window on the left and a main reinforcement 
table for the current member on the right.  The current member can be changed by 
selecting it from the pulldown menu on the second toolbar or by clicking on a member in 
the current Design Group on the Structure View window. 

 

2.12.5. Eurocode 2 Beam Shear Layout Page 
The Beam Shear Layout Page displays the shear reinforcement resulting from the 
design of the current Design Group. 
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The page is laid out with a Structure View window on the left and a Shear reinforcement 
diagram of the current member on the right.  The current member can be changed by 
selecting it from the pulldown menu on the second toolbar or by clicking on a member in 
the current Design Group on the Structure View window. 

 

2.12.6. Eurocode 2 Beam Shear Reinforcement Page 
The Beam Shear Reinforcement Page displays the shear reinforcement resulting from 
the design of the current Design Group as numerical data. 

The page is laid out with a Structure View window on the left with a Shear reinforcement 
table and a Shear Zones table on the right.  The current member can be changed by 
selecting it from the pulldown menu on the second toolbar or by clicking on a member in 
the current Design Group on the Structure View window. 

 

2.12.7. Eurocode 2 Beam Drawing Page 
The Drawing Page is used to generate a Multi-RC drawing file. 

The page is laid out with a Structure View on the left and a Bar Bending Schedule table 
for the current member on the right.  When entering the page an Export dialog box is 
automatically opened with the current beam information loaded. 

 

2.13. Eurocode 2 Beam Brief 
The Eurocode 2 Beam Brief has 6 tabs for setting out the design parameters:- 

 

2.13.1. General 
Minimum covers.  Set the cover to the top, bottom and sides of the beams. 

Bond Co-efficients.  Set the values for use in calculating the anchorage lengths. 

Aggregate size.  The maximum size of aggregate. 

Concrete Grade.  Either select a standard grade from the pulldown list or enter the 
concrete cube strength into the user value fck in N/mm2. 

Envelope.  The beams will be designed to the forces from the envelope selected from 
the pulldown list.  (See section 11.6.3 for the Define Envelope command) 

Divide Beam.  Set the minimum number of segments that each member should be 
divided into for calculating the reinforcement.  
 

2.13.2. Main Reinforcement 
Top Bar Criteria.  Set the Minimum and Maximum allowable bar sizes to be used on 
the top of the beams.  The link hanger size is used for detailing where no reinforcement 
bars are required for bending, but bars are required for supporting links.  The Min gap 
defines the spacing between the top 2 layers. 

Bottom Bar Criteria.  Set the Minimum and Maximum allowable bar sizes to be used 
on the bottom of the beams.  The link hanger size is used for detailing where no 
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reinforcement bars are required for bending, but bars are required for supporting links.  
The Min gap defines the spacing between the bottom 2 layers. 

Side Bar Criteria.  Set either the minimum bar size to be used or let the program 
calculate which bars can be used to achieve a 250mm c/c spacing on deep beams. 

Main Bar Type.  Either select a standard grade from the pulldown list or enter the steel 
yield strength into the user value and set the bending dimensions to be used with that 
strength. 

 

2.13.3. Shear Reinforcement 
Design Shear For.  Select either centre line or column face.  Select option to include 
for Enhanced Shear Effects close to supports. 

Shear Bar Criteria.  Select the minimum bar size and number of legs to be used and 
set the minimum spacing.  Select either open or closed links to determine the link shape 
codes to be used with the schedule and link to Multi-RC. 

Shear Bar Type.  Either select a standard grade from the pulldown list or enter the 
steel yield strength into the user value and set the bending dimensions to be used with 
that strength. 

 

2.13.4. Boxed Values - General 
These can all be set to a use the values from a National Application Document by 
selecting the country from the pulldown list.  Alternatively, a user set of values can be 
set. 

Partial Safety factors for concrete and steel. 

Additional factor for sustained compression. 

Maximum reinforcement percentage of tension and compression reinforcement. 

K factor used in equation 4.78 

fct(eff) factor used in equation 4.78 

sigma s used in equation 4.78 as a percentage of fyk. 

Steel stress for determining the maximum bar size in table 4.11 as a percentage of fyk. 

Steel stress for determining the maximum bar spacing in table 4.12 as a percentage of 
fyk. 

Checks on the bar spacing is not less than a) dg + 5mm when dg>32mm (always), b) 
the maximum bar diameter (optional), c) a minimum distance set by the user (optional). 
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2.13.5. Boxed Values - Anchorage’s and Laps 
Limit of overall section for a good anchorage bond in mms. 

Minimum distance from top surface to provide a good anchorage in mms. 

Minimum anchorage length in mms. 

Minimum cover perpendicular to hooks to determine alpha a factor in equation 5.4, 
measured in bar diameters. 

Co-efficient alpha 1, the upper and lower limits in bar diameters. 

The upper limit of the diameter of bar for which nominal shear reinforcement is 
sufficient at the laps in mms. 

Maximum distance between bars that are considered to be lapped, measured in 
bar diameters. 

 

2.13.6. Boxed Values - Shear 
Maximum diameter of link bars in mms 

The maximum spacing of links when VSd is greater than 2/3 VRd2 and when it is less 
than or equal to 2/3 VRd2.  Both measured in mms. 

The maximum transverse spacing of links, measured in mms. 

The upper limit of beta, the shear force enhancement coefficient used in equation 4.17. 

For equation 4.18, the following values can be set.  The values in calculating the 
constant k, the average stress in the concrete due to axial force, sigma cp and the 
maximum value of the reinforcement ratio corresponding to the area of reinforcement 
effective at the section under consideration. 

 

2.14. Eurocode 2 Column 
With this Brief there are seven pages.  Each page lays out the screen so that the user 
can easily step through the process of setting up and checking data.  They are read 
from the bottom left corner upwards. 

Summary 
Input 
Design 
Main Layout 
Shear Layout 
Result 
Drawing 
 

2.14.1. Eurocode 2 Column Summary Page 
The Summary Page displays the summary of the design of the current Design Group. 

The page is laid out with a Structure View window on the left and a Member Summary 
Table on the right. 
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2.14.2. Eurocode 2 Column Input Page 
The Input Page displays the summary of the design of the current Design Group. 

The page is laid out with a Structure View window on the left and the Column Input table 
on the right.  The Input table is used to set the directions in which columns are braced. 

2.14.3. Eurocode 2 Column Design Page 
The Design Page is similar to the Summary Page, but on entering the page the Design 
Options dialog box is opened allowing the design to be initiated. 

 

2.14.4. Eurocode 2 Column Main Layout Page 
The Main Layout Page graphically displays the main reinforcement resulting from the 
design of the current Design Group. 

The page is laid out with a Structure View window on the left and a main reinforcement 
diagram of the current member on the right.  The current member can be changed by 
selecting it from the pulldown menu on the second toolbar or by clicking on a member in 
the current Design Group on the Structure View window. 

 

2.14.5. Eurocode 2 Column Shear Layout Page 
The Beam Shear Layout Page displays the shear reinforcement resulting from the 
design of the current Design Group. 

The page is laid out with a Structure View window on the left and a Shear reinforcement 
diagram of the current member on the right.  The current member can be changed by 
selecting it from the pulldown menu on the second toolbar or by clicking on a member in 
the current Design Group on the Structure View window. 

 

2.14.6. Eurocode 2 Column Result Page 
The Result Page displays the reinforcement resulting from the design of the current 
Design Group as numerical data. 

The page is laid out with a Structure View window on the left and a main reinforcement 
table for the current member on the right.  The current member can be changed by 
selecting it from the pulldown menu on the second toolbar or by clicking on a member in 
the current Design Group on the Structure View window. 
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2.14.7. Eurocode 2 Column Drawing Page 
The Drawing Page is used to generate a Multi-RC drawing file. 

The page is laid out with a Structure View on the left and a Bar Bending Schedule table 
for the current member on the right.  When entering the page an Export dialog box is 
automatically opened with the current beam information loaded. 

 

2.15. Eurocode 2 Column Brief 
The Eurocode 2 Column Brief has 5 tabs for setting out the design parameters:- 

 

2.15.1. General 
Concrete strength, either select a standard grade or specify a user value for the 
concrete crushing strength, fck in N/mm2 (default C35/45) 

Aggregate.  Specify the largest nominal aggregate size dg in mm (default 20mm). 

Cover to the main reinforcement in mm (default 30mm). 

Steel grade of the main reinforcement bars or specify a user value of the yield 
strength fy in N/mm2 (default S400).  If a user value is selected, then the associated 
bending radii should be set as well as the anchorage of the bar. 

The Minimum and Maximum sizes of main bars to use in calculating the most 
efficient design (default Min 12 and Max 40). 

Steel grade of the shear reinforcement bars or specify a user value of the yield 
strength fyv in N/mm2 (default S220).  If a user value is selected, then the associated 
bending radii should be set as well as the anchorage of the bar. 

Minimum size of shear link bars (default 8). 

 

2.15.2. Column Factors. 
Slenderness factor, K.  Either set to 1 or automatically calculated (the default). 

Value of the inclination from vertical to be used in equation 4.61 (default 0.005). 

Effective length factors in the local y-y and z-z axes (default 1 for both) 

Area of starter bars (default 4 number 16mm diameter bars = 804mm2) 

Maximum spacing between main bars (default 300mm) 

Minimum spacing between shear links bars (default 100mm) 

 

2.15.3. Boxed Values Main 
These can all be set to a use the values from a National Application Document by 
selecting the country from the pulldown list.  Alternatively, a user set of values can be 
set. 

Partial Safety factors for concrete and steel. 

Sustained compression factor for rectangular and circular sections. 

Reinforcement percentages, both the maximum value the minimum can hold in 
equation 5.13 and overall maximum percentage of the cross section of the concrete. 
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Minimum number of bars in a circular section. 

Minimum transverse dimension of a section. 

Upper slenderness limit for the model column method. 

Checks on the bar spacing is not less than a) dg + 5mm when dg>32mm (always), b) 
the maximum bar diameter (optional), c) a minimum distance set by the user (optional). 

 

2.15.4. Boxed Values Shear 
For the selected Country the following boxed values for the shear calculations can be 
set. 

Minimum diameter of links or a fraction of the diameter of the longitudinal bars. 

Check on the minimum spacing of the links, a) a user multiple of the largest 
longitudinal bar diameter, b) the least diameter of the column, c) a minimum distance 
specified by the user.  Note that at least one of these options must be set. 

Equation 4.18.  Set the value of from which k is calculated and its minimum limit.  The 
co-efficient that sigma cp, the average stress in the concrete due to axial force, is 
multiplied by.  The limit of the reinforcement ratio corresponding to Asl. 

 

2.15.5. Member Combinations 
Select from the available list of combinations for those that are required for the design 
by selecting them and pressing the '>' button.  Pressing '>>' will select all the available 
combination results for design. 
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Section 3. Engineering Information 

3.1. Basic Principles 
3.1.1. Introduction: 

STAAD/Pro RC Designer is started by selecting the menu option Run StaadPro RC 
Design from STAAD/Pro.  When this is done a link file is produced that contains the 
basic data for creating concrete designs.  This data is created each time the program is 
started.  Additional data that is created during the use of the program is stored, such as 
the members, envelopes, design groups and design briefs is stored in a persistent file.  
This means that if the program is closed and re-opened at a later date, the data 
remains available and does not need to be re-entered. 

Note that at any time the persistent data can be removed by selecting the re-load link 
option from the File menu. 

 

3.2. Suitable member properties:- 
Concrete design can only be performed on beam elements (not plate or solid elements) 
that have been defined with the following section property commands:- 

 

3.2.1.    Beam Design Briefs 
Rectangular or Square sections 

PRISMATIC  YD  ZD 
or 
User Table  PRISMATIC 
 

Tee shaped sections 

PRISMATIC  YD  ZD  YB  ZB  
or 
User Table  TEE 
 

3.2.2.    Column Design Briefs 
Rectangular or Square sections 

Prismatic  YD 
or 
User Table PRISMATIC 
 

Circular sections 

Prismatic  YD 
(No User Table) 
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3.3. Filenames: 
These are the files that are used by STAAD/Pro RC Designer:- 

<filename>.std Structure Input file. 
 
<filename>.ben Analysis result file. 
<filename>.bmd  Analysis result file. 
<filename>.dbs  Analysis result file. 
<filename>.dsp  Analysis result file. 
<filename>.rea  Analysis result file. 
<filename>.scn  Analysis result file. 
<filename>.sec  Analysis result file. 
 
<filename>.Rei_Concrete Persistent File 
<filename>.Rei_Concrete_Link Link file 

 

All these files are stored in the same folder, the data folder. 

The program also makes use of the files SPRORC.INI and QSE.INI that are stored in 
the user’s Windows folder. 

SPRORC.INI contains the user settings for fonts, colours and the current units. 

QSE INI contains the conversion factors for the various unit settings. 

 

3.4. Engineering Information 
The information that the design uses is determined by the design code associated with 
the design group. 

 
BS8110 Beam 
BS8110 Column 
EC2 Beam 
EC2 Column 
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3.5. BS8110 Beam Design Principles 
3.5.1.    Introduction 

The BS8110 1997 Beam Design Brief is for single or multi span, prismatic, rectangular 
solid or tee shaped members.  The member sections must be setup in the ‘Section 
Property Calculator’ and assigned from the User section database.  See the ‘Section 
Property Calculator’ manual for setting up standard sections and User databases. 

 

Beams are designed for flexure, and shear only.  Each member is divided into equally 
spaced sections and  the locations of maximum positive and negative moments along 
each element that makes up the member.  The user can specify the number of 
segments to be considered between 4 and 25 for each member. 

 

3.5.2.    Design for Flexure 
The main (longitudinal) reinforcement is calculated for both sagging and hogging 
moments on the basis of the section profile and parameters defined in the Design Brief.  
Compression reinforcement is provided where required. 

 

Automatic Design Process: 
The design of a beam is based on an envelope of design forces and thus at each of the 
defined sections, the program determines the required area of steel for both the 
maximum hogging moment and maximum sagging moment at that section. 

The beam is then divided into sub-beams, those that can use the same cage 

1) Same size 

2) Same covers 

 

For each sub-beam, the sections that have the largest sagging and hogging moments 
are identified and the most efficient reinforcement is calculated for the range of bars 
specified in the Design Brief.  The program limits 8 bars in any one layer and uses a 
maximum of 2 layers. 

Critical Hogging
Moment

Critical Hogging
Moment

Critical Sagging
Moment

Zone 1 Zone 3

Zone 2
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The program then goes along the beam and checks each section to see how many bars 
from the critical sections can be removed.  The bars are only removed at the section if 
they are not required for compression reinforcement or would result in failure in a crack 
check. 

 

3.5.3.    Design for Shear 
The shear reinforcement is designed to resist the major axis shear force envelope, Fz, 
acting through the beam.  The minor axis shear and torsional forces are not considered. 

 

Automatic Design Process: 
The number of shear legs and the shear link size is specified in the Design Brief.  
Therefore the required spacing for minimum links can be defined.  The program then 
checks each section to determine the shear stress v and concrete shear capacity vc.  
From this, the section is classified as either minimum link or a high shear section.  
Adjacent sections of the same type are grouped into zones.  For non minimum link 
zones, the shear links are designed for the maximum shear force within that zone.   

If necessary, additional legs may be added to the shear links in order to restrain tension 
or compression reinforcement. 

zone 1 zonezone 3zone 2 zone 6zone 5

Minimum
Shear Links
required for
Shear Forces
between
these values.

 
 

3.5.4.    Anchorage and Bond Lengths 
Anchorage and bond lengths are calculated in accordance with the requirements of 
clause 3.12.8.  They can be displayed graphically on the Main Reinforcement diagram 
and are used for the schedule table and export to Multi-RC. 
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3.6. BS8110 Column Design Principles 
3.6.1.    Introduction 

The BS 8110 Column Design Brief is for prismatic, rectangular solid or circular shaped 
members.  As with Beam Design, section properties must be taken from the User 
databases.  See the 'Section Property Calculator' manual for setting up standard 
sections and User databases.  Members may be built up from multiple elements, but 
only the member end moments are considered, so only single height columns are 
recommended. 

 

3.6.2.    Principles 
Columns are designed for axial force and bi-axial end moments, as well as bi-axial 
shear.  Reinforcement is provided by the program based on the forces generated in the 
Analysis mode and the code clauses outlined below. 

If the member has a reinforcement cage already defined, then the program checks the 
reinforcement for compliance.  Otherwise the program will select a reinforcement cage 
from the bars and specifications of the Design Brief to minimise the area of main 
reinforcement bars.  Selecting a column member from the design group and selecting 
‘Copy’ from the ‘Edit’ menu, copies the reinforcement cage which can be pasted on 
columns in the Design Group of the same dimensions, which can then be checked with 
that same reinforcement. 

The main reinforcing bars may be modified to allow for other bars passing through the 
section and then re-checked to ensure that the design requirements are satisfied. 

All selected load combinations are used to calculate the required reinforcement.  The 
combination which produces the maximum required reinforcement area is called the 
'Guiding Load Case', and the bar arrangement is chosen based on that combination.  
Detailed printout of the design calculations is also for that combination. 

The requirements of section 3.8 of BS 8110: Part 1 1997 utilised in the design module 
are as follows:- 

CHAPTER CONTENT STATUS 
3.8 Columns  
3.8.1 
3.8.1.1 
3.8.1.2 
3.8.1.3 
3.8.1.4 
3.8.1.5 
 

General 
Symbols 
Size of columns 
Short and slender columns 
Plain concrete columns 
Braced and unbraced columns 

Program Conforms 
Program Conforms 
N/A 
Program Conforms 
N/A 
Program Conforms 
 

3.8.1.6 
3.8.1.6.1 
3.8.1.6.2 
 

Effective height of a column 
General 
End conditions 
 

 
Program Conforms with 
Beta as a user input. 

3.8.1.7 
3.8.1.8 
 

Slenderness limits for columns 
Slenderness of unbraced columns 

Program Conforms 
Program Conforms 
 

3.8.2 
3.8.2.1 
 
3.8.2.2 

Moments and forces in columns 
Columns in monolithic frames designed to resist 
lateral forces 
Additional forces induced by deflection at ULS 

 
User decision 
 
Program Conforms for 
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3.8.2.3 
 
 
3.8.2.4 
 

 
 
 
Columns in column and beam construction, or in 
monolithic braced structural frames 
 
Minimum eccentricity 

column being designed, 
not for members 
connected. 
Forces to be designed 
for are determined by 
the users own model. 
Program Conforms 
 

3.8.3 
 
3.8.3.1 
3.8.3.2 
 
3.8.3.3 
 
3.8.3.4 
 
3.8.3.5 
3.8.3.6 
3.8.3.7 
3.8.3.8 
3.8.3.9 
 

Deflection induced moments in solid slender 
columns 
Design 
Design moments in braced columns bent about 
a single axis 
Slender columns bent about a single axis (major 
or minor) 
Columns where le/h exceeds 20, bent about 
their major axis 
Columns bent about their major axis 
Slender columns bent about both axes 
Unbraced structures 
Deflection of unbraced columns 
Additional moments on members attached to a 
slender column 
 

 
 
Program Conforms 
Program Conforms 
 
Program Conforms 
 
Program Conforms 
 
Program Conforms 
Program Conforms 
Program Conforms 
N/A 
N/A 
 

3.8.4 
3.8.4.1 
3.8.4.2 
 
3.8.4.3 
 
3.8.4.4 
 
 
3.8.4.5 
3.8.4.6 
 

Design of column section for ULS 
Analysis of sections 
Design charts for symmetrically-reinforced 
columns 
Nominal eccentricity of short columns resisting 
moments and axial loads 
Short braced columns supporting an 
approximately symmetrical arrangement of 
beams 
Biaxial bending 
Shear in columns 

 
Program Conforms 
N/A 
 
N/A 
 
N/A 
 
 
Program Conforms 
Program Conforms 
 

3.8.5 
3.8.6 
 

Deflection of columns 
Crack control in columns 

N/A 
The clause states that if 
crack check is required, 
then the member should 
be checked as a beam. 

N/A is to be interpreted as either not applicable or not implemented. 

Clauses that do not appear in the list are deemed not to be considered by the program. 
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3.7. Eurocode 2 Beam Design Principles 
3.7.1.    Introduction 

The Eurocode 2 Beam Design Brief is for single or multi span, prismatic, rectangular 
solid or tee shaped members.  The member sections must be setup in the ‘Section 
Property Calculator’ and assigned from the User section database.  See the ‘Section 
Property Calculator’ manual for setting up standard sections and User databases. 

 

Beams are designed for flexure, and shear only.  Each member is divided into equally 
spaced sections and the locations of maximum positive and negative moments along 
each element that makes up the member.  The user can specify the number of 
segments to be considered between 4 and 25 for each member. 

 

3.7.2.    Design for Flexure 
The main (longitudinal) reinforcement is calculated for both sagging and hogging 
moments on the basis of the section profile and parameters defined in the Design Brief.  
Compression reinforcement is provided where required. 

 

Automatic Design Process: 
The design of a beam is based on an envelope of design forces and thus at each of the 
defined sections, the program determines the required area of steel for both the 
maximum hogging moment and maximum sagging moment at that section. 

The beam is then divided into sub-beams, those that can use the same cage 

1) Same size 

2) Same covers 

 

For each sub-beam, the sections that have the largest sagging and hogging moments 
are identified and the most efficient reinforcement is calculated for the range of bars 
specified in the Design Brief.  The program limits 8 bars in any one layer and uses a 
maximum of 2 layers. 

Critical Hogging
Moment

Critical Hogging
Moment

Critical Sagging
Moment

Zone 1 Zone 3

Zone 2
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The program then goes along the beam and checks each section to see how many bars 
from the critical sections can be removed.  The bars are only removed at the section if 
they are not required for compression reinforcement or would result in failure in a crack 
check. 

 

3.7.3.    Design For Shear 
The shear reinforcement is designed to resist the major axis shear force envelope, Fz, 
acting through the beam.  The minor axis shear and torsional forces are not considered. 

 

Automatic Design Process: 
The number of shear legs and the shear link size is specified in the Design Brief.  
Therefore the required spacing for minimum links can be defined.  The program then 
checks each section to the concrete shear capacity Vrd1.  From this, the section is 
classified as either minimum link or a high shear section.  Adjacent sections of the 
same type are grouped into zones.  For non minimum link zones, the shear links are 
designed for the maximum shear force within that zone.   

If necessary, additional legs may be added to the shear links in order to restrain tension 
or compression reinforcement. 

zone 1 zonezone 3zone 2 zone 6zone 5

Minimum
Shear Links
required for
Shear Forces
between
these values.

 
 

3.7.4.    Anchorage and Bond Length 
Anchorage and bond lengths are calculated in accordance with the requirements of 
Eurocode 2.  They can be displayed graphically on the Main Reinforcement diagram 
and are used for the schedule table and export to Multi-RC. 
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3.8. Eurocode 2 Column Design Principles 
3.8.1.    Introduction 

The Eurocode 2 Column Design Brief is for prismatic, rectangular solid or circular 
shaped members.  As with Beam Design, section properties must be taken from the 
User databases.  See the 'Section Property Calculator' manual for setting up standard 
sections and User databases.  Members may be built up from multiple elements, but 
only the member end moments are considered, so only single height columns are 
recommended. 

 

3.8.2.    Design Principles 
Columns are designed for axial force and bi-axial end moments, as well as bi-axial 
shear.  Reinforcement is provided by the program based on the forces generated in the 
Analysis mode and the code clauses outlined below. 

If the member has a reinforcement cage already defined, then the program checks the 
reinforcement for compliance.  Otherwise the program will select a reinforcement cage 
from the bars and specifications of the Design Brief to minimise the area of main 
reinforcement bars.  Selecting a column member from the design group and selecting 
‘Copy’ from the ‘Edit’ menu, copies the reinforcement cage which can be pasted on 
columns in the Design Group of the same dimensions, which can then be checked with 
that same reinforcement. 

The main reinforcing bars may be modified to allow for other bars passing through the 
section and then re-checked to ensure that the design requirements are satisfied. 

All selected load combinations are used to calculate the required reinforcement.  The 
combination which produces the maximum required reinforcement area is called the 
'Guiding Load Case', and the bar arrangement is chosen based on that combination.  
Detailed printout of the design calculations is also for that combination. 

The main reinforcing bars may be modified to allow for other bars passing through the 
section and then re-checked to ensure that the design requirements are satisfied. 

The requirements of Eurocode 2 utilised in the design module are as follows:- 

CHAPTER CONTENT STATUS 
2 Basis of Design  

2.3.3.2  Fundamental safety values default 

2.5.1.3.(4)  vν (nu) value used in column design 

3 Material Properties  
3.1.2.3.(4)  Equations 3.2 and 3.3 used 

3.1.2.4  Followed 

3.2.4.1  fyk used 

3.2.4.3.(1)  Followed 

4 Section and Member Design  
4.1.3.3.(5)  Followed 

4.2.1.3.3.(9)  Followed for all section types except 
flanged beams
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flanged beams 

4.2.1.3.3.(10) 

   &(12) 

 Simple rectangular concrete stress 
block used in the design of flanged 
beams 

4.2.1.3.3.(11)  Followed 

4.2.2.3.2.(4)&(5)  Followed using horizontal flat top 
branch 

4.3.1.2.(6)  Followed 

4.3.2.2.(1)  Followed 

4.3.2.2.(2)  Followed 

4.3.2.2.(7)  Standard method followed 

4.3.2.2.(9)  Followed 

4.3.2.3.(1)  Followed 

4.3.2.4.2.(3)  Followed 

4.3.2.4.3.(1)  Followed 

4.3.2.4.3.(2)  Followed 

4.3.2.4.3.(4)  Followed 

4.3.5.3.5.(2)  Followed 

4.3.5.4.(3)  Followed 

4.3.5.5.3.(2)  Followed 

4.3.5.5.3.(3)  Followed 

4.3.5.5.3.(4)  Followed 

4.3.5.5.3.(5)  Followed 

4.3.5.5.3.(6)  Followed 

4.3.5.6.1.(1)  Followed 

4.3.5.6.2.(1)  Followed 

4.3.5.6.3.(2)  Followed 

4.3.5.6.3.(5)  Followed 

4.3.5.6.3.(6)  Followed 

4.3.5.6.4.(1)  Followed 

4.3.5.6.4.(2)  Followed 

4.3.5.6.4.(3)  Followed 

4.3.5.7.(2)  Followed 

4.4.2.2.(3)  Followed 

4.4.2.3.(2)  300mm max spacing limit is applied 
in all cases. 

The max bar size limit is not applied. 

4.4.2.3.(5)  Followed 

4.4.3.2.(2)  Followed 

4.4.3.2.(3)  Followed 
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4.4.3.2.(4)  Followed 

4.4.3.2.(5)(a)  Followed 

4.4.3.2.(5)(b)  Followed 

4.4.3.2.(5)(c)  Followed 

5 Detailing Provisions  
5.2.1.2.(2)  The 'hooks, bends, loops' part of 

table 5.1 is followed 

5.2.2.1.(2)  Followed 

5.2.2.1.(3)  Followed 

5.2.2.2.(2)  Followed 

5.2.2.3.(2)  Followed 

5.2.3.2.(1)  Followed 

5.2.3.3.(2)  Followed 

5.2.3.3.(3)  Followed 

5.2.3.3.(4)  Followed 

5.2.3.4.1.(1)  Followed 

5.4.1  Followed 

5.4.1.1.(1)  Followed 

5.4.1.2.1.(1)  Followed 

5.4.1.2.1.(2)  Followed 

5.4.1.2.1.(3)  Followed 

5.4.1.2.1.(4)  Followed 

5.4.1.2.2.(1)  Followed 

5.4.1.2.2.(3)  Followed 

5.4.2.1.1.(2)  Followed 

5.4.2.2.(1)  Followed (always 90 degrees) 

5.4.2.2.(5)  Followed 

5.4.2.2.(7)  Followed 

5.4.2.2.(9)  Followed 
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Section 4. Reference 

4.1. Commands 
These are the commands that are available from the menus.  The menus and items 
change depending on the mode and the type of current window, e.g. Graphic or Table. 

 

4.1.1.    FILE 
Open Link File    
Re-open..    
Save     
Job Information  
Report Setup...   
Printer Setup...   
Print     
Print Preview   
Exit    
 

4.1.2.    EDIT 
Undo    
Cut     
Copy    
Copy Picture   
Paste    
Delete    
Take Picture   
Go To...    
 

4.1.3.    VIEW 
Zoom    
Tables...    
Structure Diagrams...   
Colours...    
Design Results  
Orientation   
Labels...    
Whole Structure  
Open View...    
New View...    
View Management Detach View   

Add to View   
Save View   
Rename View   

Toolbars...       
Options...       
 

4.1.4.    SELECT 
Elements Cursor 
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Members Cursor 
Select All 
By Member...  
By Section Property...  
By Design Group...  
New Design Group...  
 

4.1.5.    MEMBERS 
Members Table 
Form Member 
AutoForm Members 
 

4.1.6.    BRIEF 
Design Brief 
Design Brief Table 
 

4.1.7.    GROUP 
Select By Design Group 
Group Members List Table 
New Design Group 
Design Group Table 
Member Summary 
 

4.1.8.    DESIGN 
Design Options 
Design Now 
 

4.1.9.    RESULTS 
Design Results Setup 
Individual Graphs 
Main Reinforcement Diagram 
Shear Reinforcement Diagram 
Plan View 
Beam Spans 
Main Reinforcement 
Shear Links 
Shear Zones 
Deflection 
Scheduled Bars 
Member Summary 
Clear Results 
 

4.1.10. DRAWING 
Export to Multi RC 
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4.1.11. MODE 
Design Layer 
Design 
Page Control 
 

4.1.12. WINDOW 
Cascade 
Tile Horizontal 
Tile Vertical 
Arrange Icons 
Structure Only 
 

4.1.13. HELP 
Contents 
Search for Help On...  
Using Help 
About STAAD/Pro RC  
 

4.2. Open Link File  Ctrl+N 
Opens the link file and ignores the data in the persistent file. 

 
Keyboard Shortcut CTRL+N 
 

4.3. Re-open...      Ctrl+O 
Opens the link file and includes the data in the persistent file. 

Effectively restarts the RC Designer, removing any data that has been added since the 
current RC Designer session started. 

Open button 
Keyboard Shortcut CTRL+O 
 

4.4. Save            Ctrl+S 
Saves the data that has been generated in the RC Designer in a persistent file 
<filename>.Rei_Concrete. 

To save a structure quickly, click the Save button on the Standard toolbar. 

Save button 
Keyboard Shortcut CTRL+S 
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4.5. Job Information 
Displays the Job Info window for the active structure.  General information and 
comments about the structure can be recorded here.  When first opened, the dialog is 
populated with the data that is in the STAAD/Pro data file. 

 

Some of the Job Information is printed in the header on every page of the reports.  The 
rest may be printed in the special Job Information report item. 

Job 
The job title (up to 100 characters) is printed in the report header. 

Client 
The client name (up to 100 characters) is printed in the report header. 

Job No. 
The job number (up to 100 characters) is printed in the report header. 

Part 
The part reference (up to 100 characters) is printed in the report header. 

Ref 
The reference (up to 100 characters) is printed in the report header. 

 
 
 
Quality Assurance 
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Six edit boxes are available for recording information required by quality assurance 
procedures.  There are spaces (10 characters) for the names or initials of the Engineer, 
the Checking Engineer and the Approving Engineer, together with dates.  

The name, initials and date of the engineer and checker are printed on the report 
header. 

 
Comments 
Up to 1000 characters of comments can be typed into this edit box.  The comments 
appear on the special Job Information report item. 

 

4.6. Report Setup... 
The Report Setup command is sensitive to the current mode and to the current design 
code if in Design mode.  

 
 

 Dialog Box Options 
Items 

Available 
The Available list shows the tables and pictures that can be included in the report.   

Select an item by clicking then item, then clicking the ‘>’ button to transfer it to the 
Selected list. More than one item can be selected at once by holding down the CTRL 
key while selecting.  A range of items can be selected by click and dragging up or 
down the list or clicking on the first item and clicking on the last whilst holding down 
the SHIFT key. 

Items are always added to the bottom of the Selected list. All the items in the Available 
list can be selected by clicking the ‘>>’ button. 

Selected 
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The Selected list shows the tables and pictures to be included in the report, in the 
order in which they will appear. 

To remove an item from the Selected list, highlight it by clicking and then click the < 
button to return it to the Available list. 

All the items can be removed from the Selected list by clicking the ‘<<’ button. 
 

Detailed Results 

Available 
The Available list shows the detailed items that can be included in the report if the 
‘Design Detail’ item is included in the Items list (see above). 

Selected 
The Selected list shows the detailed items that will be included in the report if the 
‘Design Detail’ item is included in the Items list (see above). 

 

Members 

Available 
The Available list shows the members that can be included in the report. 

Selected 
The Selected list shows the members that will be included in the report. 

 

Design Briefs 

Available 
The Available list shows the detailed items that can be included in the report if the 
‘Other Brief’s Details’ item is included in the Items list (see above). 

Selected 
The Selected list shows the detailed items that will be included in the report if the 
‘Other Brief’s Details’ item is included in the Items list (see above). 

 

Picture Album 

The Picture Album shows the pictures that have been captured for inclusion in the 
report.  It also allows the captions for these pictures to be edited. 

Name 
Select the picture to view using the drop-down list. 

Caption 
Edit the caption for the picture in this edit box.  The caption appears printed below the 
picture in the report. 

Delete 
Removes the picture from the picture album. 

Full Page 
This sets the current picture to take a full page in the printout if it is an included item. 
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Options 

Sets options for how the printed pages of the report appear. 

Header 
Check this option to include a header on the report.  Note that  the header contains 
the Sheet Numbering, company Name and Logo, and much of the Job Info. 

Page Outline 
Check this option to add an outline to each page of the report. 

Footer 
Check this option to include a footer on the report.  Note that the print run information, 
that is page numbers, time and date, is included on the footer. 

Prefix 
Sheet numbers are printed at the top right of each page.  Edit the prefix for sheet 
numbers here.  The prefix is printed one space in front of the sheet number. 

Leave the text box empty if a prefix is not needed. 

No. Pages From 
Give a number from which to start the sheet numbering.   

Leave this text box empty if you do not wish QSE Space to number the report's pages 
at the top right of the page.  Note that if the footer of the report is included, there is 
always a record of the order of the pages. 

Suffix 
Edit the suffix for the sheet numbers at the top right of the page.  Leave this text box 
empty if a suffix is not needed. 

Grid 
Check the Grid option to draw the grid lines in the data tables of the report.  Leaving 
the grid lines off increases printing speed on some printers. 

Start each table on a new page 
Check this option to start each new data table on a new report page.  This option is 
useful for reports on very large structures, but it wastes paper on small structures 
where the tables are short. 

Table Heading 
Click on the Font button to show the Font dialog for the table headings in the report.  
Choose a new font using the dialog and click the OK button to return to the Report 
Setup dialog. 

Table Text 
Click on the Font button to show the Font dialog for the table text in the report.  
Choose a new font using the dialog and click the OK button to return to the Report 
Setup dialog. 

 

Reverse Page Order 
Some printers do not turn over the pages that they have printed.  This results in a 
printed report coming out back to front.  If your printer does this, then check the 
Reverse Page Order option and QSE Space will print the last page first!  
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Name and Logo 

Configures the company name and logo area of the report page.  This is situated in 
the box between the Research Engineers logo (top left) and the Job No. box. 

Preview 
Shows a preview of how the company name and logo appear. The company name is 
edited directly by typing in the preview. 

Graphic File 
Click on the File button to insert a Windows Metafile graphic file into the company logo 
area. 

Graphic Paste 
A bitmap or Windows Metafile can be pasted into the company logo area.  To do this, 
click on the Paste button.  If the button is shaded out, the clipboard does not contain 
graphical data. 

Position 
Adjust the position of the graphic using these options. If the graphic is placed in the 
centre, then the company name does not appear. 

Font 
Click on the Font button to change the font and size of the text used for the company 
name. The text itself is edited directly in the Preview area. 

Alignment 
Adjust the alignment of the company name using these options.  The company name 
is aligned within the space left after the company logo (if any) is drawn.  Note that if 
the logo is placed in the center then the company name does not appear (although it 
is not deleted). 

 
Load/Save 

This allows the user to save a report setup which can be recalled at a later date.  The 
arrangement of Items, Members and Design Briefs with the sort options are saved. 

When a picture is deleted, it is removed from all reports. 

A Saved Report Setup can be deleted. 
 

4.7. Printer Setup... 
Displays the Print Setup dialog box.  This provides a list of installed printers, sets the 
default printer, and provides access to other printing options for the printer selected. 

Before printing from RC Designer for the first time, do the following: 

1)  Connect the printer to the computer or a network by using the instructions in the 
printer's manual. 

2)  Install a printer driver using the Windows Setup or Windows Control Panel.  For 
more information refer to the Windows documentation. 

3)  Select the printer to be used from the Print Setup dialog. 

Dialog Box Options 
Default Printer 
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Displays the name of the default printer and shows the printer's connection. 

Printers 
Selects the printer to be used.  Only printers that have been installed are listed here.   
For more information refer to the Windows documentation. 

Set As Default Printer 
Changes the default printer that RC Designer uses to print reports.  Select the printer to 
be used in the Printers list and then choose this button. 

Options 
Changes the printer settings from the printer selected in the Printers list.  The options 
vary according to the printer driver installed. 

To get Help for the selected printer, press the Options button and then press the Help 
button in the Options dialog. 
Network 
Connects the computer to a printer across a network.  For more information refer to the 
Windows documentation or press Help in the Network dialog. 

 

4.8. Print          Ctrl+P 
Controls how the RC Designer report is printed.  Before using this command, install and 
select a printer.  For more information refer to the Windows documentation. 

The appearance and content of the RC Designer report can be configured using the 
Report Setup command on the File menu. 

To print one copy of the report quickly, using the current Report Setup, click on the Print 
button on the Standard toolbar. 

Print button 
Keyboard Shortcut CTRL+P 

Dialog Box Options 
Printer 
Displays the name of the active printer and printer connection. 

Print Range 
Select how much of the report is to be printed. 

Click on the All option to print all the pages of the report. 

Click on the Pages option to print a selection of pages. Enter a selection of pages 
separated by commas, or a range separated by a hyphen. 

Alternatively, enter the first page number of a range in the From text box and the last 
page number in the To text box. 

Setup 
Displays the Print Setup dialog.  This is equivalent to choosing the Printer Setup 
command from the File menu. 
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4.9. Print Preview 
Shows how the RC Designer report appears when printed. Use the buttons at the top of 
the print preview window to inspect the report.  The arrangement and contents of a 
report are set up in the Report Setup.  

When satisfied with the print preview, click the Print button to send the report to the 
current printer.  This is the same as the Print command on the File menu.   

When entering the print preview, RC Designer repaginates the report and retrieves all 
the current data it needs, so the preview is the same as would be printed. 

To show the print preview quickly, click the Print Preview button on the standard toolbar. 

Print Preview button 

 
 

4.10. Exit 
Ends the current RC Designer session.  If any additional data has been added, RC 
Designer prompts to save this in the persistent file. 

RC Designer can also be exited by one of the following. 

1)  Open the application control menu by pressing the ALT and Spacebar keys together. 

2)  Double click on the application control menu box. 

Application control menu 
 



Section 4 43 

 

4.11. Undo         Ctrl+Z 
Reverses the last change made to the active structure.  The name of the command 
depends on the most recent action taken - for example: Undo Delete. 

RC Designer cannot undo some actions.  If the most recent action cannot be undone, 
then the name of the command reverts to Undo and it is disabled. 

To quickly reverse the most recent action on the active structure, click on the Undo 
button on the Standard toolbar. 

Undo button 
Keyboard Shortcut CTRL+Z 
 

4.12. Cut          Ctrl+X  
Removes the selected table data and puts it on to the Clipboard.  Data cut to the 
clipboard replaces the previous contents of the clipboard. It remains on the clipboard 
until new data is cut or copied. 

This command is only available once a valid selection has been made in the active 
window. 

To quickly cut information to the clipboard, make a selection and then click the Cut 
button on the Standard toolbar. 

Cut button 

Keyboard Shortcut CTRL+X 
 

4.13. Copy         Ctrl+C 
Copies the selected table data and puts it on to the Clipboard.  Data that is copied to the 
clipboard replaces the previous contents of the clipboard. It remains on the clipboard 
until new data is cut or copied. 

This command is only available once a valid selection has been made in the active 
window. 

To quickly copy information to the clipboard, make a selection and then click the Copy 
button on the Standard toolbar. 

Copy button 
Keyboard Shortcut CTRL+C 

 

4.14. Copy Picture 
Copies the picture in the active structure window to the clipboard.  No selection is 
needed for this command to work.  The picture replaces the previous contents of the 
clipboard and can be pasted into any windows application that supports graphics such 
as MS Word or MS Excel. 
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4.15. Paste        Ctrl+V 
Inserts a copy of the data on the clipboard into the active window.   

If the data on the clipboard is empty or is unsuitable for pasting into the active window, 
then the command is disabled. 

Table Rows 
When pasting into a table, any selected rows are overwritten.  The paste command for 
a table keeps the data in the same order as it is on the clipboard.   

If the data on the clipboard is longer than the selection in the active table, then the paste 
fills in any blank rows before appending the remaining data to the end of the table. 

If the data on the clipboard is narrower than the active table, the data is pasted into the 
columns on the left of the table, leaving other columns unchanged or displaying default 
values. 

If paste comes across an empty field in the clipboard data, it leaves any existing data 
alone, or enters a default value. 

Tip 
To paste quickly, click the Paste button on the Standard toolbar. 

Paste button 

Keyboard Shortcut CTRL+V 
 

4.16. Delete       Del 
Deletes the selection in the active window.  A selection must be made for this command 
to be available. If the current window is a structure, a warning message is shown 
allowing the command to be cancelled if required. 

 

Tip 
If a mistake is made, use the Undo command on the Edit menu to reverse the delete.  
This must be done immediately after the mistake or the Undo may not be available. 

Keyboard Shortcut Del 
 

4.17. Take Picture 
Copies the picture in the active structure window to the report picture album.  No 
selection is needed for this command to work.   

 

Tab Options 
Id 
This gives the photograph a name that is displayed in the Items list and Picture Album 
of a Report Setup. 

Caption 

This sets the caption to be used if the picture is a selected item in the Report Setup 
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To quickly copy the picture to the picture album, click the Take Picture button on the 
Standard toolbar. 

Take Picture button 
Photographs are stored for future use in a separate file in the same folder as the 
structure file with the same filename but with the file extension .REI Saved Picture. 

 

4.18. Go To...     F5 
Scrolls the active table window so that a given row is visible.  Shows the Go To Row 
dialog in which the row number to move to may be given. 

Keyboard Shortcut F5 
 

4.19. Zoom 
Opens a Zoom Window onto the active structure window.   

When the Zoom command is chosen, the cursor changes to a cross (+).   

Define a zoom area on the structure window.  Press down the left mouse button on one 
corner of this area, hold down the button and move the mouse (drag) to open up the 
area.  The zoom area is outlined with a dotted box as it is dragged.  Release the mouse 
button when the area is the desired size. 

A <Zoom> window is now opened showing the zoom area enlarged.  If the Highlight 
Zoom Area option is checked in the options dialog, a box appears on the structure 
window, locating the extents of the zoom window. 

Only one zoom window per structure window can be open.  A zoom window cannot be 
opened from another zoom window.  However, the scale of zoomed area can be 
increased or decreased by clicking on the ‘+’ or ‘-‘ buttons on the bottom right of the 
zoom window. 

Zoom Extents Button 
Clicking on the ‘E’ button to zoom to the extent of the structure view. 

Holding the CTRL key down and pressing one of the direction keys on the keyboard will 
rotate the structure on the original and zoomed windows. 

To quickly open a zoom window, click the Zoom button on the Standard toolbar. 

Zoom button 
To move the position of the zoom window use either the scroll bars on the window, the 
cursor keys on the keyboard or the Viewpoint buttons on the toolbar.  The cursor keys 
and the viewpoint buttons, move the viewing point around the structure. 

Viewpoint buttons 
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4.20. Tables... 
Displays the Tables dialog. This displays any of the table windows in RC Designer. 

Dialog Box Options 
Tables 
The list shows the table names next to check boxes which show whether they are being 
displayed.  Click in the check boxes to show or hide a table window. 

In the case of the Load Summary table, the Tables dialog affects only the load summary 
associated with the active structure window. 

List 
The Design Input and Design Results options can be used to limit the list of tables to 
help find items more easily. 

 

4.21. Structure Diagrams... 
Displays the Structure Diagrams dialog, which has five tabs, for the active structure 
window. 

Tip 
To quickly show the Structure Diagrams dialog, click the Structure Diagrams button on 
the Standard toolbar. 

 Structure Diagrams button 

 

 Dialog Box Options 

4.21.1. General Tab 
Margin Around Structure 
Sets the percentage of the window to allow around the structure to allow for drawing 
force diagrams. 

 

4.21.2. Results Tab 
Sets the results to be displayed and their colours. 

LoadCase 
A pulldown list of all defined loadcases and combinations. 

 
Forces 
Check boxes to toggle the display of the particular force on the structure.  The colour on 
the adjacent button shows the colour of that diagram.  Click on the button to select an 
alternative colour. 

Increments 
This sets the number of intermediate results that are shown for each element. 
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4.21.3. Scales Tab 
Sets the scales that loads and results are to be displayed to.  Note that units for each 
item is set in the Options dialog.  If the range does not provide a suitable scale, try 
alternative units. 

Load Scale  Range 0.001-999999 

Bending Scale  Range 0.001-999999 

Shear Scale  Range 0.001-999999 

Axial Scale  Range 0.001-999999 

Torsion Scale  Range 0.001-999999 

Displacement Scale Range 0.001-999999 

Stress Scale  Range 0.001-999999 

Load Scale  Range 0.001-999999 

 

4.21.4. Labels Tab 
Displays the Labels page of the Diagrams dialog for the active structure window. 

Label Check Boxes 
Node Labels  Nodes Numbers 

Node Points 
Supports 

Element Labels Element Numbers 
Orientation Labels 
Element Length 

Property Labels None (select option) 
Reference (select option) 
Section (select option) 

Member Labels Member Numbers 
Group References 

General   Axes Diagram 

 

The dialog contains check boxes for configuring which labels appear on the structure 
diagram in the active window.   

The user must choose between display of section property References or the names of 
the Sections. 

 

4.21.5. Force Limits Tab 
This allows the user to colour the stick line model of the structure to indicate which 
elements have end forces or stresses that fall outside a specified range. 

Label Case 
A pulldown list of all loadcases, combinations and envelopes.  Note that loadcase 
chosen in this pulldown updates the similar pulldown on the Results tab and vice versa. 

View Limits 
Choose the range. Whether the maximum limit, minimum limit or both should remain 
within range. 
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Colour within limit 
Click on the coloured box to change the pass colour and set the thickness of line in 
pixels between 1 and 10 (structure elements are always drawn 1 pixel wide). 

Colour outside limit 
Click on the coloured box to change the fail colour and set the thickness of line in pixels 
between 1 and 10 (structure elements are always drawn 1 pixel wide). 

 

4.22. Colours... 
Displays the Colour Manager dialog for the active structure window. 

Structure Colours 
Sets the colours used in various highlights. 

Analysis Results 
Sets the colours for the Forces (see also Structure Diagrams) and element Limits. 

Design Results 
Sets the colours for the Pass/Fail ratios and member Efficiencies. 

Current Structure Colour Scheme 
Sets the colours for the drawing the wire frame of the structure.  The chosen scheme is 
shown on the status bar. 

 

4.23. Orientation         F4 
Displays the Orientation dialog.  This adjusts the orientation and projection of the picture 
of the structure in the active structure window. 

The Orientation dialog is modeless; it floats on top of the other windows in RC 
Designer.  Changes can be seen in the active window if the Apply Immediately check 
box is selected. 

 Dialog Box Options 
View 
Choose between Isometric and Perspective drawing. 
Default Orientation To 
Click on one of these buttons to set the Elevation, Distance and Rotation to default 
values. 

Distance to Structure 

The distance from the viewpoint to the origin of the structure. 
Elevation Angle 
The height above ground level (global Z = 0) for Perspective drawing, or the projection 
angle used for Isometric drawing. 
Rotation Angle 
The rotation of the structure about the global Z axis. 
Apply Immediately 
Check this box to see the picture in the active structure window redraw as soon as 
changes are made in the dialog. 
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Apply 

Click this button to apply the changes in the dialog to the drawing in the active structure 
window. This button is not needed if the Apply Immediately box is checked. 

Restore 

Restores the values in the dialog to those that were current when it was opened.  Be 
careful because any changes made are lost. 

Close 
Closes the dialog and applies any changes made to the picture in the active structure 
window. 

To cancel changes, click on the Restore button before clicking on Close. 

Tips 
Keyboard Shortcut F4 
Use the arrow keys to move the view point when a structure window is active. 
The picture in the active structure window can be adjusted without using the Orientation 
dialog because eight of the options are available on the Standard toolbar as buttons. 

 

Button  Name  Action 

 
X-Z Side 
Elevation 

Draws the side elevation in the active 
window 

 
Y-Z End 
Elevation 

Draws the end elevation in the active 
window 

 
X-Y Plan Draws the plan in the active window 

 
X-Y-Z 
Isometric 

Draws the default isometric in the 
active window 

 
Viewpoint Left Moves the viewpoint to the left 

 
Viewpoint 
Right 

Moves the viewpoint to the right 

 
Viewpoint Up Moves the viewpoint up 

 
Viewpoint 
Down 

Moves the viewpoint down 

 

4.24. Labels... 
Displays the Labels tab of the Diagrams dialog. 

To quickly show the labels dialog, click on the Labels button on the Standard toolbar. 

 Labels button 
There is a Labels toolbar.  Use the Toolbars command on the View menu to show this 
toolbar.  The labels toolbar and many of the Page Control toolbars have buttons which 
control individual labels as follows. 
 

Button Name Action 
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Node 
Labels 

Draws node labels (toggle) in 
the active window 

 Node 
Points 

Draws a spot (toggle) at the 
location of the nodes in the 
active window 

 
Element 
Labels 

Draws element labels (toggle) 
in the active window 

 Element 
Length 

Draws the length of each 
element (toggle) in the active 
window 

 
Member 
Labels 
 

Draws member labels (toggle) 
on elements in the active 
window 

 
Property 
Labels 

Draws section property 
reference labels (toggle) in the 
active window 

 
Section 
Names 

Draws section name labels 
(toggle) in the active window 

 
Orientation 
Symbols 

Draws orientation symbol 
labels (toggle) in the active 
window 

 
Axes 
Diagram 

Draws the axis key diagram 
(toggle) in the active window 

 
Support 
Symbols 

Draws support symbol labels 
(toggle) in the active window 
(not S1) 

 
Release 
Symbols 

Draws release symbol labels 
(toggle) in the active window 
(not R1) 

 
Group 
Labels 
 

Draws design group 
references (toggle) on 
elements in the active window 

 

4.25. Whole Structure 
Creates a new whole structure window.  The program can display multiple whole 
structure windows of the structure, each showing different information, e.g. different 
loadcases, bending moments, displacements etc.  They may be created at any time.  
However, the next time the structure file is opened, only one whole structure window is 
shown.  

 

4.26. Open View... 
Opens a saved view of the structure.  Displays the Open View dialog.  A view 

 Dialog Box Options 
Views 
Choose the view to be opened from the list of stored views. 

Options 
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A new window in which to open the view can be created, or the view can be opened in 
the currently active structure window.  Click OK to open the view. 

 

4.27. New View... 
Creates a new view window from the selection of elements in the active window. One or 
more elements must be highlighted in the active window before the New View option 
becomes available. 

If elements are accidentally omitted from the new view, use Add to View  

If elements are to be excluded from the new view, select the required elements, then 
use New View to create a corrected view. Close the view window which shows the 
incorrect selection. 

 

4.28. View Management 
Displays a sub menu with various commands to help manage the views of the structure 
in RC Designer. 

 

4.28.1. Detach View 
Detaches the active view from the active structure's data file.  Once a view is detached, 
it regains a title with <Untitled> in it and is lost when closing the view window, the data 
file or exiting RC Designer. 

A view window must be active for this command to be available. 

 

4.28.2. Add to View 
Adds elements which are selected in the active window to another view window which 
has already been created. 

To create a view window, use the New View command. 

One or more elements must be highlighted in the active window before the Add to View 
option becomes available.   

It does not matter if selected elements already exist in the target view, as they remain 
selected.  

 

 Dialog Box Options 
 
Structure 
The file name of the active structure is displayed. 

Views 
Select the view name to which the selected elements are to be added. 

 

4.28.3. Save View 
Saves the view in the active window in the data file for the active structure. The view 
window can then be closed without loosing the view. 



52 Section 4 

 

Use Save View to save a copy of the view in the active window under a new name. 

A view window must be active for this command to be available. 

If the content, diagrams or annotation of a saved view are changed, the view is marked 
as changed by having an asterisk * added to its name.  A view with a * appended to it’s 
name must be saved in order to retain the changes. 

Because RC Designer uses an asterisk at the end of a view name to indicate that it has 
changed since it was last saved, it is not recommended to use an asterisk in a view 
name. 

 

4.28.4. Rename View 
Renames the view in the active window. 

Before a view can be renamed, it must be saved.  

A saved view must be active for this command to be available. 
 

4.29. Toolbars... 
Displays the Toolbars dialog which configures the toolbars that are shown. 

 Dialog Box Options 
Toolbars 
The names of the various toolbars provided in RC Designer are listed next to the 
check boxes.  Check the box next to a toolbar name to show the toolbar. 

Large Buttons 
RC Designer provides two sizes of toolbar buttons.  Check the Large Buttons box if 
RC Designer is run on a very high resolution screen or if you have difficulty seeing the 
normal size buttons.   

Although increasing the button size may help you, it also reduces the space in which 
RC Designer can draw the structure. 

Show Tool Tips 
This option is helpful for learning what the toolbar buttons in RC Designer mean.  RC 
Designer displays a short name (Tool Tip) for the button in a small box if the mouse 
cursor is placed over a toolbar button for one second. 

When familiar with the buttons, the Tool Tips can be turned off by leaving this box 
unchecked. 

 

Tips 
Choose one of the first three toolbars on the list from a pop-up menu that appears if 
the right mouse button is clicked over a visible toolbar. The Toolbars command can 
also be accessed in this manner. 

When the mouse cursor is placed over a toolbar button, the Status Bar displays a 
sentence explaining what the toolbar button does.  
 

4.30. Options... 
Displays the Options dialog.  This dialog configures many of the graphical features of 
RC Designer.  The options dialog has eight tabs. 
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 Tab Options 
 

4.30.1. Tables Tab 
Contains a button to configure the font used in the tables in RC Designer.   

Click on the Font button to change the font.  A sample of the font chosen is displayed. 

Note that this font is only used when Page Control is turned off.  This is because with 
Page Control turned on and a very large font would cause problems on pages that have 
wide tables and picture views. 

 

4.30.2. Node Labels Tab 
Contains the options for configuring how the node labels on the picture of the structure 
appear, if used. 

To turn Node Labels on, use the Labels command on the View menu.   

A sample of how the node labels appear is provided. 

Text

Pixels Above

Pixels Right

node

 
Style 
Choose the style of the node labels. 

 
 
Horizontal Alignment 
Choose an option for the horizontal alignment of the node label with respect to the start 
point for the text. 

Vertical Alignment 
Choose an option for the vertical alignment of the node label with respect to the start 
point for the text. 

Pixels Right & Above 
Enter the distance in pixels from the node to the start point for the text. 

Font 
Click on the Font button to change the font used for the label.  The font colour can also 
be changed here. 

Opaque 
Check this box to make the label opaque.  This obscures any structure or diagram 
behind the label, ensuring that it can be read. 

 

4.30.3. Annotation Labels Tab 
Contains the options for configuring how the annotation labels on the picture of the 
structure appear, if used. 



54 Section 4 

 

To turn Annotation ON, use the Annotation command on the View menu.. 

A sample of how the labels appear is provided. 

Style 
Choose the style of the labels. 

Horizontal Alignment 
Choose an option for the horizontal alignment of the label with respect to the start point 
for the text. 

Vertical Alignment 
Choose an option for the vertical alignment of the node label with respect to the start 
point for the text. 

Pixels Right & Above 

origin

Text

Pixels Above

Pixels Right

origin

Element

Result  
The annotation labels origin is situated halfway along a line joining the element to its 
results graph.  Enter the distances in pixels from the origin to the start point for the text. 

Font 
Click on the Font button to change the font used for the label.  The font colour can also 
be changed from here. 

Opaque 
Check this box to make the label opaque.  This obscures any structure or diagram 
behind the label, ensuring that it can be read. 

 

4.30.4. Element Labels Tab 
Contains the options for configuring how the element labels on the picture of the 
structure appear, if used. 

To turn Node Labels ON, use the Labels command on the View menu.   

A sample of how the node labels appear is provided. 

Elements Style & Properties Style 
Choose the style of the labels. Configure the style used for the property independently 
of the style used for the element reference.  The property reference is appended to the 
element reference separated by a colon. e.g.  E34 : P2 

Horizontal Alignment 
Choose an option for the horizontal alignment of the label with respect to the text start 
position. 

Vertical Alignment 
Choose an option for the vertical alignment of the label with respect to the text start 
position. 

Pixels Right & Above 
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Text

Pixels Above
Pixels Right

 
The text start point is positioned with respect to the center point of the element.  Enter 
the distance in pixels from the element center to the start point for the text. 

Font 
Click on the Font button to change the font used for the label.  The font colour can also 
be changed from here. 

Opaque 
Check this box to make the label opaque.  This obscures any structure or diagram 
behind the label, ensuring that it can be read. 

Angle Text 
Check this box to angle the label along the line of the element.  If this box is unchecked, 
the label is drawn horizontally. 

 

4.30.5. View Highlights Tab 
Contains the options to configure the appearance of the highlights between structure 
windows in RC Designer. 
View Highlight 
Changes the view highlight colours of the elements in the active view or in the whole 
structure window, if it is open.  This helps locate elements in the view. 

Check the Highlight in the Whole Structure window box to see this highlight. 

Zoom Area  
The zoom area of a Zoom window is highlighted on the original window.  It helps locate 
the zoomed in area on the original. 

Check the Zoom Area box to use this highlight. 

Width 
Edit the width of the highlights using the edit box.  

 

4.30.6. Structure Units Tab 
Contains the options to configure the displayed structure units.  Internally the program 
stores units using the SI convention. The conversion factors for other units are stored in 
the file QSE.INI.  Other units can be added to this file. 

Dimension 
Options selected from the list below section [Length] in QSE.INI. 

Displacement 
Options selected from the list below section [Length] in QSE.INI. 

Springs-Linear 
Options selected from the list below section [Spring Stiffness] in QSE.INI. 

Springs-Rotational 
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Options selected from the list below section [Rotational Spring Stiffness] in QSE.INI. 

Temperature 
Options selected from the list below section [Temperature] in QSE.INI. 

Weight 
Options selected from the list below section [Mass] in QSE.INI. 

 

4.30.7. Section Units Tab 
Contains the options to configure the displayed cross sectional units.  Internally the 
program stores units using the SI convention. The conversion factors for other units are 
stored in the file QSE.INI.  Other units can be added to this file. 

Area 
Options selected from the list below section [Area] in QSE.INI. 

Inertia 
Options selected from the list below section [2nd Moment of Area] in QSE.INI. 

Dimension 
Options selected from the list below section [Length] in QSE.INI. 

E,G (Youngs Modulus, Shear Modulus) 
Options selected from the list below section [Pressure or Stress] in QSE.INI. 

Density 
Options selected from the list below section [Density] in QSE.INI. 

Alpha (co-efficient of thermal expansion) 
Options selected from the list below section [Alpha] in QSE.INI. 

 

4.30.8. Force Units Tab 
Contains the options to configure the displayed forces units.  Internally the program 
stores units using the SI convention. The conversion factors for other units are stored in 
the file QSE.INI.  Other units can be added to this file. 

Force 
Options selected from the list below section [Force] in QSE.INI. 

Distributed Force 
Options selected from the list below section [Distributed Force] in QSE.INI. 

Moment 
Options selected from the list below section [Moment] in QSE.INI. 

Distributed Moment 
Options selected from the list below section [Distributed Moment] in QSE.INI. 

Stress 
Options selected from the list below section [Pressure or Stress] in QSE.INI. 

Acceleration 
Options selected from the list below section [Acceleration] in QSE.INI. 
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4.31. Elements Cursor 
Choosing one of the cursor commands changes the cursor shape and its selection 
function when it is over a structure window.  The elements cursor allows individual 
analytical elements to be selected and joined into design members.  

 Elements Cursor  
The cursor currently selected is indicated by a tick against the menu item and is 
designated as the current selection mode.  It also remains as a depressed item on the 
toolbar. 

 

4.32. Members Cursor 
Choosing one of the cursor commands changes the cursor shape and its selection 
function when it is over a structure window.  The members cursor allows members to be 
selected and grouped into Design Groups.  In the Design mode, selecting a member 
with the members cursor makes that member the current member and displays the 
information relating to that member. 

 Members Cursor 
The cursor currently selected is indicated by a tick against the menu item and is 
designated as the current selection mode.  It also remains as a depressed item on the 
toolbar. 

 

4.33. Select All 
The action of the Select All command depends on the current selection mode and 
cursor. 

If the Select Elements cursor is current then all the elements in the active structure 
window are selected. 

If the Select Nodes cursor is current then all the nodes in the active structure window 
are selected. 

If the Select Element Ends cursor is current then all the element ends in the active 
structure window are selected.  Note that this may look similar to all the elements being 
selected, but it is not the same. 

 

4.34. By Member... 
Selects members in the active structure window by their member numbers. 

Displays the Select Members dialog which contains a single list box with all the member 
numbers. The selection in this list reflects any selection already made on the active 
structure window. 

Extend the selection in the list by holding down the CTRL key while selecting new 
members.  To remove a selection from the list, hold down the CTRL key and click on 
the item. 

Click OK to transfer the selection to the active structure window.  
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4.35. By Section Property... 
Selects elements in the active structure window according to their section property. 

Displays the Select by Property dialog which contains a list of the section properties 
defined in the active structure and the option of ‘No Property’ (a useful check to see that 
all elements do have a property prior to analysis). 

Click on properties in the list to select them. Extend the selection by holding down the 
CTRL key and clicking on further properties. 

Click the OK button to update the selection in the active structure window. 

To quickly show the Select by Property dialog, click the Select by Property button on 
one of the toolbars. 

 

4.36. By Design Group... 
Before selecting by Design Group, at least one design group must be defined.   

This command displays the Select Design Groups dialog which contains a list of the 
groups defined in the active structure. 

Click on groups in the list to select them. Extend the selection by holding down the 
CTRL key and clicking on further groups. 

Click the OK button to update the selection in the active structure window. 

 

4.37. New Design Group... 
A Design Group is the selection of members that are to be designed with one of the 
QSE Designer modules. 

Before defining a new Design Group, one or more members must be selected in the 
active structure window.   

This command displays the New Design Group dialog. 

 Dialog Box Options 
Name 
Type a new name or select one from the list. 

Design Brief 
Select a Design Brief from the pulldown list.  The Design Briefs are the design 
parameters to which the Design Group will be designed. 

 

4.38. Members Table 
Displays the Members Table window for the active structure. This table is un-editable, 
but clicking on a member reference number will highlight that member on the diagram. 

Table Columns 
Mem The reference number of the member. 
Emt The elements that form the particular member. 
A B The nodes that define the start and end of the element. 

Prop A, Prop B The reference of the section properties at the start and end 
of the element. 
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Length  The length of the element (in the chosen units). 

O. length The overall length of the member, reduced by any cutbacks 
if applied (in the chosen units). 

 Members Table button 
 

4.39. Form Member 
Forms a structural member from a selection of one or more connected elements. 
Elements must be selected for this command to be available. 

If the selection of elements is not connected then the form member command uses the 
first connected part of the selection only.  A warning regarding this appears. 

To view the members in the structure, use the Member Labels option in the Labels 
dialog which is available from the Labels command on the View menu. 

To form a member, the following rules must be obeyed. 

1)  All elements must form a single continuous line.  But they do not have to form a 
straight line.  Thus curved members may be formed. 

2)  There must be a free end.  Whilst curved members are allowed, they cannot form a 
closed loop. 

3)  All elements must have the same beta angle. 

4)  All elements must point in the same direction.  Check with the orientation labels if 
necessary.  Use the reverse element command on elements that point the wrong way. 

5)  None of the elements can be part of another member. 

6)  The section properties must be consistent at each element end.  Elements can taper 
along their length, but where one element ends and the next starts, they must have the 
same section reference. 

7)  All elements must be made from the same material. 

 

 Form Member button 
 

4.40. AutoForm Members 
Forms a number of Members from a selected range of elements.  Each member will 
obey the general rules for generating a member specified above, but uses the following 
rules in addition. 

Vertical elements are converted into columns first. 

Where four elements cross and share a single node, if the elements can form two 
members, the deeper section will form a continuous member, but the other 
elements will form parts of two separate members. 

 AutoForm Member button 
 

4.41. Design Brief 
A Design Brief is a set of design parameters, which allows the Concrete Design checks 
to be done.  Each Design Brief is setup for a particular Design Code. 
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Briefs are independent of Member Design Groups so that the same brief can be re-
used for several design groups. For example, you may have several groups of beams 
but only one brief for beams. Alternatively, you may tailor each brief to each member 
group. 

Available Codes: 

BS8110 Beam  
BS8110 Column  
Eurocode 2 Beam 
Eurocode 2 Column 

 Design Brief dialog button 
 

4.42. Design Brief Table 
The Design Briefs table lists the design briefs already defined and the codes of practice 
used for each brief. 

To edit an existing brief, either double click the table entry or select the entry with the 
cursor and then press the Edit Brief button. 

To change the design code for a brief, select the code entry with the cursor and select a 
new code from the pull down.   

 

4.43. Select By Design Group 
Before selecting by Design Group, member groups must be defined for the structure.   

Displays the Select Design Groups dialog which contains a list of the groups defined in 
the active structure. 

Click on groups in the list to select them. Extend the selection by holding down the 
CTRL key and clicking on further groups. 

Click the OK button to update the selection in the active structure window 

 

4.44. Group Members List Table 
This option displays a list of the members in the current design group with their Analysis 
and Design sections. 

 Table Columns 

Mem   Shows the member number 

Analysis Section   Shows the section used in the last analysis 

Design Section  Shows the section from the last design, last analysed section 
if no design has been done. 

To remove a member from the group, highlight the entry in the table and delete with the 
delete key. 

To add a member to the deign group, type the member number, omitting the “M”, in the 
first column of the table. 

Note that the contents of the two columns “Analysis Section” and “Design Section” can 
not be changed. 
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4.45. Design Group Table 
This table is opened automatically when the Des.Groups option in Page Control Mode is 
selected. 

To open this table when not running in Page Control Mode, select the table from the 
table list.  To display the table list, use the menu option View/Tables. 

 

 Table Columns 
Column 1 Shows the group reference G? 

Design Group Shows the name of the design group. 

Design Brief Shows the design brief to be used in designing the group. 
 

4.46. Design Options 
Opens the Design Options dialog.  This has a single tab. 

 Design Options button 

 

4.46.1. Member Select Tab 
Available 
The Available list shows the members in the current group that have not been selected. 

Select a member by clicking on it, then clicking on the > button to transfer it to the 
Selected list. More than one member can be selected at once by holding down the 
CTRL key while selecting. 

Select all the members in the Available list by clicking on the >> button. 

Selected 
The Selected list shows the members to be included in the design. 

To remove a member from the Selected list, highlight it by clicking on it, then click on 
the < button to return it to the Available list. 

 

Once the options have been set, a design can be initiated by clicking on the Design 
button. 

 

4.47. Design Now 
Designs the current group according to the settings in the Design Options dialog. 

 

4.48. Design Results Setup 
Opens the Design Results Setup dialog.  This has two tabs. 

 Tab Options 
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4.48.1. Display Groups Tab  
Choose the design groups for which results are to be displayed in the graphics window. 

Available 

The Available list shows the groups for which results may be displayed. 

Select a group by clicking on it, then transfer it to the Selected list by clicking on the > 
button. Select more than one at once by holding down the CTRL key while selecting. 

All the groups in the Available list can be selected by clicking on the >> button. 

Selected 
The Selected list shows the groups for which results are displayed. 

To remove a group from the Selected list, highlight it by clicking on it, then click on the < 
button to return it to the Available list. 

All the groups can be removed from the Selected list by clicking on the << button. 

 

4.48.2. Colour Config Tab  
The colour coding of the results display can be configured. 

Select the “None” check box and no results are shown on the graphic. 

Select the “Pass/Fail” check box to activate the left hand option list.  Select the options 
to display by picking the check boxes. 

To reconfigure the colours used for the various options, pick one of the colour blocks 
next to the option list.  This brings up the Design Results Pass/Fail Colours dialog.  Pick 
the item to be changed from the pull down list, then select the colour to be used for 
displaying this item from the palette displayed. 

Select the “Efficiencies” check box to activate the right hand option list. 

To reconfigure the colours used for the various options, pick on one of the colour blocks 
next to the option list.  This brings up the Design Results Efficiency Colours dialog.  Pick 
the item to be changed from the pull down list, then select the colour to be used for 
displaying this item from the palette displayed. 

 

4.49. Individual Graphs 
Creates Element/Member Results Graph windows for the elements/members selected 
in the active structure window.  Each window can show results of multiple  force types 
and multiple loadcases, combinations and/or envelopes. 

A selection of elements/members must be present in the active structure window before 
this command is available. 

To change or add load cases or lines to the graph, use the Diagrams command from 
the View menu. 

 Dialog Box Options 
Load Cases 
Select the load cases for which the graphs are to be drawn. More than one load case 
can be selected by holding down the CTRL key during selection. 

Forces 
Select the forces graphs to be drawn. 

Colours 
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Click on this button to customize the colours of the graphs .  This button displays the 
Graph Colours dialog.  Select a graph from the drop-down list and then set its colour by 
clicking on the palette. 

Tips 
Change the load case displayed in an element graph window by using the drop-
down list of load cases on the Results toolbar or right clicking over the Graph 
window. 

To show the element graphs quickly, click on the Element Graphs button on the 
Results toolbar. 

 Element Graphs button 
 

4.50. Main Reinforcement Diagram 
Displays the result of the design on the current member. The diagram is divided into 
parts which can be resized by dragging the separator.  A Beam Design produces a 
different diagram to a column design. 

 

4.50.1. Beam Design 
There are three parts to a Beam design diagram.  The top section displays an elevation 
of the member with the reinforcement layout, the centre section the major axis design 
moment envelope (Mz) with the design capacity and the lower section a cross section of 
the beam. 

The location of the cross section can be determined by dragging the section marks on 
the top two parts of the diagram or by typing in the distance from the start of the beam 
and clicking on the set button. 

The cross section shows locations of bars at that cross section with a dot and bars that 
occur elsewhere along the beam at that location with a ‘+’. 
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4.50.2. Column Design 
There are three parts to a Column design diagram. 

 
From left to right, the first section displays the major axis moment envelope (Mz) with 
the design capacity, the second section displays an elevation of the column.  The final 
section is a typical cross section through the column. 

 

4.51. Shear Reinforcement Diagram 
Displays the shear result of the design on the current member. The diagram is divided 
into three parts that can be resized by dragging the separator.  A Beam Design 
produces a different diagram to a column design. 

 

4.51.1. Beam Design 
There are three parts for a beam design.  The top section displays an elevation of the 
member with the shear reinforcement layout, the centre section the design shear force 
envelope (Fy) with the design capacity and the lower section a cross section of the 
beam. 

The location of the cross section can be determined by dragging the section marks on 
the top two parts of the diagram or by typing in the distance from the start of the beam 
and clicking on the set button. 

The cross section shows locations of bars at that cross section with a dot and bars that 
occur elsewhere along the beam at that location with a ‘+’. 
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4.51.2. Column Design 
There are three parts to a Column design diagram. 
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From left to right, the first section displays the major axis shear force envelope (Fy) with 
the design capacity, the second section the minor axis design shear force envelope (Fz) 
with the design capacity.  The final section is a typical cross section through the column. 

 

4.52. Plan View 
Toggles the view on the top section of a main or shear reinforcement diagram to display 
the reinforcement from an elevational view to a plan view. 

 

4.53. Beam Spans 
Displays the Beam Spans table.  This has two tabs Spans and Supports. 

The Spans tab allows the user to setup individual covers and link sizes for each span.  
The values for the Covers and Link Size are initally set by the values from the Design 
Brief, but can be editied and set seperatly for each span. 

 
The Supports tab allows the user to define the size and type of support that can be 
used for shear enhancement.  Both the Support Type (No support, Simple or Fixed) and 
Support Width can be set. 

 
A span is defined as the distance between two supports.  The program will attempt to 
identify any nodes that would be considered as supports, but the user can override 
these assumptions and assign appropriate supports. 

 

4.54. Main Reinforcement 
Displays the Main Reinforcement table.  This shows the design moments, required 
steel areas and provided steel bars for each location along the beam that was checked. 
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Values that are displayed in green indicate sections where the reinforcement that is 
provided is to meet the minimum reinforcement requirements, as the design moment is 
too small.  Values that are displayed in red indicate that not all the design requirements 
were met for the provided reinforcement. 

 

4.55. Shear Links 
Displays the Shear Links table.  This shows the shear forces and stresses at the 
design locations along with the required steel area. 

 
 

4.56. Shear Zones 
Displays the Shear Zones table.  The result of the shear design, the program divides 
the beams into a number of shear zones where the provided shear reinforcement 
remains constant. 
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4.57. Deflection 
Displays the Span / Effective table.  This is the check to ensure that the limit of 
effective depth divided by the actual span is not exceeded. 

 
 

4.58. Scheduled Bars 
Displays the Bar Bending Schedule table. 

 
 

4.59. Member Summary 
Displays the Member Summary table.  This shows where the members in the Design 
Group have passed or failed to meet the design requirments. 

 
 

4.60. Clear Results 
Clears all the results the designs of the current Design Group. 

 

4.61. Export to Multi RC 
Displays the Export to Multi-RC dialog box.  This will create a DXF file of the current 
member that can be read into the AutoCAD application Multi-RC (please contact your 
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Research Engineers supplier for more information on this product).  The file will contain 
elevations, sections and a bending schedule. 

The dialog box is comprised of five sections:- 

 

4.61.1. Preview Window 
This shows how the member will appear when imported into Multi-RC with the current 
settings. 

4.61.2. Size and Spacing 
This sets the size of paper that the drawing is to be imported into and scale of the 
drawings to be generated. 

4.61.3. Title Block 
This is used for guidance so that the user can position the drawing without encroaching 
the space that is provided for title blocks in the final drawing. 

4.61.4. Cut Section 
When the current beam is a multiple span, then the beam can be cut at support 
locations and the next section is then continued below. 

4.61.5. Spacing 
There are three values that are used to locate the drawings onto the drawing sheet.  
The 1st Span Left and 1st Span Top locate the top left corner of the first span relative 
to the top left corner of the drawing.  The value Separation Constant defines the 
distance between sections of a beam that have been cut using the Cut Section as 
outlined above. 
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4.62. Design Layer 
Switches the operating mode of RC Designer to the Design Layer mode and page 
layout to the Job Information Page. 

 

4.63. Design 
Switches the operating mode of RC Designer to the Concrete Design mode associated 
with the current design code. 

 

4.64. Page Control 
Toggles the Page Control menu on the left hand side of RC Designer. 

 

4.65. Cascade 
Arranges the windows in RC Designer in an overlapping pattern so that the title bar of 
each window remains visible. 

 

4.66. Tile Horizontal 
Arranges the windows in RC Designer so that all the windows which are not minimized 
do not overlap and are as wide as possible.  Any minimized window icons are arranged 
in a gap underneath the tiled windows. 

 

4.67. Tile Vertical 
Arranges the windows in RC Designer so that all the windows which are not minimized 
do not overlap and are as tall as possible.  Any minimized window icons are arranged in 
a gap underneath the tiled windows. 

 

4.68. Arrange Icons 
Arranges the icons of any minimized RC Designer windows into rows across the bottom 
of the MDI window. This command does not affect the size or position of any open 
windows. 

 

4.69. Structure Only 
Closes all RC Designer windows for the active structure except for a single whole 
structure window.  If a whole structure window is not currently open, then RC Designer 
creates a new one. 
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4.70. Contents 
Displays the contents page of the RC Designer Help system.  The Help system contains 
sections for Overview, Engineering Information, Using RC Designer step-by-step, 
Options and a Command Reference. 

When looking through Help, the Contents page can be returned to by clicking on the 
Contents button in the RC Designer Help window. 

 

4.71. Search for Help On... 
Searches in Help for information about a given keyword.  Shows the Search dialog. 

In the Search dialog, type the topic or select it from the list.  Then click on the Show 
Topics button to see the related topics.  To view the Help on a particular topic, select it 
and click on the Go To button. 

 

4.72. Using Help 
Displays the How to Use Help window which gives more information on using Help. 

 

4.73. About STAAD.Pro RC  
Displays the name and version of the program.  Also gives the address of Research 
Engineers, whom you may wish to contact for the details of our latest software. 
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